
APPLICATION NOTE

User Guide for 1W Multi-Channel RF Passive Entry
System

ATAN0029
Kit Contents

● Complete system solution capable of:

● Multichannel RF remote keyless entry (RKE)
● LF passive entry/passive start (PEPS)
● Vehicle immobilization (IMM)
● Stand-alone operation eliminates need for STK600

● Key fob variants include:

● Integrated RF transmitter and Atmel® ATtiny44V microcontroller (Atmel ATA5774)
● Integrated RF transmitter and 1D LF IMM (Atmel ATA5795C)
● Integrated RF transmitter, 3D LF PEPS receiver, and 1D LF IMM (Atmel ATA5791)

● Car side components include:

● 6-channel 125KHz PEPS antenna coil driver (Atmel ATA5279C)
● Integrated 125KHz IMM base station plus Atmel ATtiny87 (Atmel ATA5272)
● Intelligent RF receiver (Atmel ATA5782)

● Open system software including:

● PEPS protocol with high-precision 3D localization
● RKE RF rolling code using AES-128
● Immobilizer stack using AES-128
● Scalable and configurable
● PC GUI for system visualization and viewing data communication

● Body computer emulation using Atmel ATmega2560 on the main PCB

Overview

This document provides setup and usage instructions for the car access reference system 
(CARS) which features remote keyless entry, passive entry/passive start, and vehicle 
immobilization. It offers a complete system in which it is possible to evaluate the compre-
hensive family of car access products offered by Atmel. Reference designs are used which 
are both scalable and configurable, enabling adaptation of the basic hardware and soft-
ware building blocks to satisfy system requirements.
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1. Getting Started

1.1 Kit Contents

This kit contains the following items

● PCBs:

● Atmel® ATAB0001A-V2.0 CAR system interface board

● Atmel ATAB5279C 6-channel coil driver PCB (Atmel ATA5279/ATA5279C)

● Atmel ATAB5782C-V1.0 receiver application board (Atmel ATA5781/ATA5782/ATA5783)

● Atmel ATA5272-EK1 immobilizer base station application board (Atmel ATA5272)

● Key fobs/transponders:

● Atmel ATA5580M256-TSMW immobilizer transponder (Atmel ATA5580)

● Atmel ATA5771/73/74-EK1 RF transmitter application board (Atmel ATA5771/73/74)

● Atmel ATA5795-EK1 RF transmitter with 1D LF immobilizer application board (Atmel ATA5795)

● Atmel ATAB5791A-V1.0 RF transmitter with 3D LF PEPS and 1D LF immobilizer application board 
(Atmel ATA5790N+)

● Cables, connectors, other:

● ISP interface adapter board 

● UHF antenna

● 2 x ATAB-LFTX-V2.0 LCR PEPS antenna board

● Circular immobilizer coil

● USB cable

● 120/240AC to 12VDC wall transformer

● Quick start guide

Note: CR2032 lithium coin cell batteries (3) are required for normal operation of each handheld transmitter PCB and 
are not included with the kit.
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1.2 Connecting the Hardware

Figure 1-1. System Hardware Assembly 

Mount the following adapter boards on top of Atmel® ATAB0001A-V2.0 interface PCB:

● LF driver adapter board: Atmel ATAB5279 6-channel coil driver board

● LF base station/immobilizer adapter board: Atmel ATA5272-EK1 base station application board

● RF receiver adapter board: adapter board for the Atmel ATAB5782 RF receiver application board

For each board, align X1 and X2 pin headers to the X1 and X2 pin sockets on the CAR system interface board and be sure 
to set pin 1 on X1 and the X2 headers to pin 1 on the X1 and X2 pin sockets.

Connect the RF antenna to the RF receiver adapter board at location X4. 

Locate the LF coil and connect its wire, terminated with a snap-in connector, to TPA1N/TPA1P on the 6-channel coil driver 
board.

Attach the round immobilizer coil to the XANT1 base station application board connector. 

Complete the setup by connecting the auxiliary 12VDC power from the wall transformer to the corresponding sockets on the 
LF driver adapter. 
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All hardware modules come with their correct software configuration preprogrammed in all individual PCB components. 
Once all the modules are assembled and the power is connected, the power-up status appropriate for the system is 
indicated by 
the LED0 - LED7 briefly switching on and then switching off again. 

Note: This kit requires only one LF antenna to be connected.

1.3 PC Graphical User Interface

To improve the user experience, this kit includes a graphical user interface (GUI). It is provided to assist in the visualization 
of system operation and contains both visual animation and audio feedback of common car access system functionality.

To activate this feature, locate the USB port on the ATAB0001A-V2.0 PCB and establish a USB cable connection with the 
PC. Upon power-up install the USB driver located in the development software package. The following sections explain how 
to properly install the driver.

Launch the PC application with “ATAK51003-V1_PC_Application.exe” in your distribution files and double-click on it to 
launch it. The opening screen appears as shown in Figure 1-2.

Figure 1-2. PC GUI Opening 

1.3.1 Installing the USB Driver for Windows XP

To enable ATAB0001A-V2.0 (the main PCB) and the GUI communication, use the mini-USB plug to connect the host PC 
and the target PCB to the J12 connector via the USB interface cable. 

For Windows XP once the USB cable is plugged into the target PCB the “Found New Hardware Wizard” message is 
displayed as shown in Figure 1-3 on page 5. 

Note that on a different operating system installation the process might work differently.

Locate the USB driver from the download in the previous step by following the directory path: 
… \atak51003-v1_toolpack\Software\1.Precompiled_Object_Files\ atmel_devices_cdc.inf.

Note: This uses the Net Framework 2.0 or later system drivers.
ATAN0029 [APPLICATION NOTE]
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USB driver installation dialog boxes are shown in the following screenshots.

Figure 1-3. Screenshot 1 
5ATAN0029 [APPLICATION NOTE]
9306C–RKE–03/15



Figure 1-4. Screenshot 2 
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Check the COM port number in the Device Manager to verify that the installation was successful. There should be an 
EVK1XXX Virtual COM Port (COMy) device available, with “y” indicating the COM port number (12) shown in Figure 1-5.

Figure 1-5. Virtual COM Port Assignment in Windows XP 

1.4 Installing the USB Driver for Windows 7

Locate the USB driver from the download in the previous step by following the directory path
… \atak51003-v1_toolpack\Software\1.Precompiled_Object_Files\ atmel_devices_cdc.inf.

Connect the mini-USB plug to the J12 connector on the CAR system interface board as shown in Figure 1-5 above.

Open the Computer - Manage dialog as shown in Figure 1-6 and right-click the computer entry.

Figure 1-6. Computer - Manage Dialog in Windows 7 
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Under Computer Management mark Device Manager and right-click the computer name for opening the Add legacy 
hardware dialog as shown in Figure 1-7.

Figure 1-7. Device Manager - Add Legacy Hardware Dialog 

Select the “Install the hardware ...” dialog from the Add Hardware Wizard and press Next> as shown in Figure 1-8.

Figure 1-8. Add Hardware Wizard - Install Selection Dialog 
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Select Show All Devices and click the “Have Disk …” button in the next window as shown in Figure 1-9.

Figure 1-9. Add Hardware - Show All Devices - Have Disk … Dialog 
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Choose the “Browse…” button and select the directory for the driver file “atmel_devices_cdc.inf” as shown in step a. above 
and open the files as shown in Figure 1-10.

Figure 1-10. Locate File Dialog 

Select “EVK1XXX Virtual Com Port” from the models listed in the following input dialog and press Next> to install the driver 
as shown in Figure 1-11.

Figure 1-11. Select Device Driver Dialog 
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When the Windows Security dialog appears, choose “Install this driver software anyway” as shown in Figure 1-12.

Figure 1-12. Windows Security Dialog 

Finally the Add Hardware Wizard dialog appears as shown in Figure 1-13 which can be closed by clicking Finish.

Figure 1-13. Completing the Add Hardware Wizard Dialog 
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Now connect the USB cable to your PC and verify the COM port settings and number as shown in Figure 1-14 below.

Figure 1-14. Device Manager with Ports Settings 

1.4.1 Selecting the COM Port

Open the CARS_PC_Application.exe application and configure the serial USB communication settings using the virtual 
COM port following these steps:

● To choose the communication (COM) port, select “COM > PORT” and click the installed virtual COM port in the pull-
down menu

● To choose the COM port speed, select “COM > Baud Rate” and in the pull-down menu click 57600 

● To confirm the open port, check the status port message at the bottom of the screen (e.g., COM11: Open) to see if the 
selected port has been activated. The port state is toggled from open to closed and closed to open by clicking the 
display message

Figure 1-15. Serial Communication Setup 
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1.4.2 System Configuration Window

Go to View > System Configuration to open the system configuration window. 

The system configuration window displays specific software information, the status of the learned fobs, selects the PEPS 
authentication method, and selects a PEPS fob for experimenting range testing. A PEPS fob is used for calibration and to 
provide experimental parameters stored by each fob selected. 

It consists of the following functional sections:

● LF antennas section: This includes antenna radial buttons used to select the antenna channel and the current and 
associated vehicle ID.

● Antenna channel: This controls what antenna channel is used to transmit the LF message from the vehicle. The 
antenna only functions properly if connected to the corresponding port on the ATAB5291A board.

● Antenna current: This determines the amount of current flowing in the antenna during the LF message. The field 
strength at a given distance from the antenna determines the level of the current. Therefore, any change to this value 
has a direct impact on the performance of localization during PEPS.

● Vehicle ID: This sets the wake-up value sent out with the LF message. Only fobs that are looking for this value will 
wake up and respond. The vehicle ID is set in the fob during the learn mode.

● Learned fobs section: This consists of four individual fob IDs which have been paired to the system and saved in 
memory. The “Learn” button is used to perform the initial pairing of any new fobs to the system using the immobilizer 
LF field provided by the base station coil. The “Clear” button erases the saved secret keys on the fob and 
configuration data from the system memory.

● PEPS features section: This provides configuration of how the PEPS messaging form responds. The type of 
authentication during polling can be selected as well as a polling interval. The polling allows the range and threshold 
performance to be easily checked. The in/out threshold can be specified by entering a new value or by pressing the 
“RSSI CAL” button on the ATAB0001A board. It is possible to choose what fob should be given priority during the anti-
collision process in the last part of this section.

● PEPS fob actions 

This section allows one fob to be specified for querying fob IDs, comparing software versions with vehicle IDs, and other 
actions. There is also an “LF Test” tab to display the currently saved normalization and compensation values as well as raw 
external and internal RSSI read figures. The distance scale value is the combined result of all post-RSSI processing and is 
compared with the in/out threshold value to determine the location. The “Calibrate Fob” button initiates a calibration cycle 
which provides reference values in order to calculate normalization and compensation constants. This is typically done 
during end-of-line testing at the manufacture. It also includes “Parameter Access” tab to display general user memory 
sections of the fob EEPROM that can be accessed via the PEPS system link. These are configured into 32 blocks of 
memory. Each block has 16 bytes of data available. The data can be displayed in HEX or ASCII format. The fob has to be 
set to a diagnostic mode using a password to access the memory. This is accomplished by pressing the “Enter Diag” button. 
After doing so, the fob responds to read or write commands for several seconds. 

Note: Each block of user memory is actually stored in the fob as three copies. The fob compares these copies to pre-
vent corruption.
13ATAN0029 [APPLICATION NOTE]
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Figure 1-16. System Configuration Section 

1.4.3 RKE Message Status Window

To open individual windows relating to specific functionality, go to View > RKE Messaging. This opens the RKE Message 
Status window.

The RKE Message Status window displays current status information pertaining to the RF unidirectional message sent by 
the fob to the RF car receiver and includes

1. RF Message S/N: The 4-byte fob serial number (ID) is displayed

2. RF Message Counter: Includes a 4-byte message counter but displayed in decimal format so the rolling counter 
can be clearly seen

3. RF Message Command: Includes one command byte which is decoded into a function

4. RF Message MAC: Consists of a 4-byte message authentication code

The “RF Message Result” field displays either a valid or invalid authentication message.

To provide additional robustness against noise, the RKE message is sent on three UHF channels. 

1. RF Channel: The RF channel currently being received is displayed

2. RF RSSI: The RSSI value measured at the vehicle UHF receiver is displayed in decimal notation, dBm, and as a 
bar graph.

A log file can be stored which creates a new record line in a comma separated variable (CSV) document for each received 
message.
ATAN0029 [APPLICATION NOTE]
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Figure 1-17. RKE Message Status 

1.4.4 PEPS Message Status Window

The PEPS message window is used to control and indicate the status of the PEPS functionality. To display this window, go 
to

● View > PEPS Messaging. This opens the PEPS Message Status window.

The PEPS message window displays a set of fields for each associated key (e.g., Key#1-Key#4) which includes the

● Serial Number: Displays the received key fob ID. This should correspond to the value in the “Learned Fobs” section in 
the System Configuration window. The background of this value changes to green if this fob was the first one received 
during the anti-collision process. This shows which fob was used for all system actions (e.g., Lock/Unlock/Start).

● LF Challenge: Displays the LF challenge 4-byte data which was sent to the fob. This challenge data is sent during 
bilateral and unilateral authentication.

● LF Encrypted Challenge: Displays the LF encrypted 4-byte data sent to the fob during bilateral authentication only.

● RF MAC: Displays the received RF message authentication code (MAC) value from the given fob.

● Localization: Displays the current localization status of the given fob (e.g., inside or outside the vehicle). This is 
determined by comparing the distance scale value with the in/out threshold value shown in the System Configuration 
window. A fob found “inside” shades the entire area in light blue while an “outside” fob shades the area in light red. 
This facilitates localization from a great distance while the system range is tested.

● Distance Scale: Indicates the received RSSI scale value.

● “Battery Low” status box displays the low battery status of the specific key fob when checked.

BA and UA buttons are used to start a single bilateral or unilateral authentication sequence directly.

Note: A continuous polling sequence can be achieved via the System Configuration window.

A log file can be stored which creates a new record line in a comma separated variable (CSV) document for each received 
message.
15ATAN0029 [APPLICATION NOTE]
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Figure 1-18. PEPS Message Status 

1.4.5 Immobilizer Status Window

Immobilizer functionality is controlled and its status monitored by using the Immobilizer Status window.

To open the Immobilizer Status window, go to

● View > Immobilizer 

The Immobilizer Status window displays a set of status fields which include

● Immobilizer UID: Displays received unique ID value. 

● Immobilizer Challenge: Displays the most current challenge data sent to the fob. Used in unilateral and bilateral 
authentication scenarios. The length depends on the configuration file used, but the kit default is 104 bits or 13 bytes.

● Immobilizer Encrypted Challenge: Displays the encrypted challenge which is used during bilateral authentication. It 
serves as the means for the immobilizer fob to authenticate the base station. The length depends on the configuration 
file used, but the kit default is 56 bits or 7 bytes.

● Immobilizer Response: Displays the key fob response data received by the base station. The length depends on the 
configuration file used, but the kit default is 56 bits or 7 bytes.

● Immobilizer Result: Displays the status of the most recent authentication.

The “Read UID” action button sends the “LF read UID” command to the fob to read its UID value.

The “Start Authentication” button sends the “Start authentication” command to the fob. The authentication type is configured 
in the base station and the fob configuration memories and must be set either to UA or BA.

A log file can be stored which creates a new record line in a comma separated variable (CSV) document for each received 
message.
ATAN0029 [APPLICATION NOTE]
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Figure 1-19. Immobilizer Window 

Figure 1-20. Configuration and Message Status Windows 
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2. Car Access Reference System Functionality

This section explains each of the subsystems comprised in a typical car access system; remote keyless entry (RKE), 
immobilizer (IMM), passive entry (PE), and passive start (PS).

2.1 Immobilizer (IMM)

The immobilizer feature is typically used in vehicles to restrict those who can start engines to authorized users only. 
Attempts to start the engine without an authenticated link between key and vehicle are blocked and immobilizes the vehicle.

2.1.1 Immobilizer Learn Mode

The immobilizer system functionality can only be observed if immobilizer enabled fobs have been paired with the vehicle. 
This requires the transfer of two secret keys from the vehicle’s control module to the key fob/transponder. These two secret 
keys are random numbers generated on demand and must be sent to the key fob.

The new fob is learned by the system by placing a fob as indicated in Figure 2-1 (the fob must be placed within 2cm of the 
base station antenna while pressing SW4 on the ATAB0001A-V2).

LED5 flashes once to indicate learning has been completed successfully. After this the location of the stored fob (LED0 - 
LED3) turns on and the Learn Mode icon (a graduate cap) is displayed briefly on the PC GUI. For optimum results, align the 
axis of the base station and fob coils in parallel. This process can be repeated for all key fobs containing devices with 
immobilizer functionality such as the Atmel® ATA5791 or Atmel ATA5795.

Note: The RKE learn mode requirements are also met during IMM learning process for devices with an integrated 
immobilizer. One of the two programmed secret keys is shared with RKE and the rolling code counter is also 
read out from EEPROM during the IMM learn sequence. This means successful LF learn mode automatically 
results in a successful RF learn mode.

Up to four key fobs can be paired (learned) with the vehicle.

Figure 2-1. Atmel ATA5791 Immobilizer Programming 

Note: The immobilizer coil is configured to be part of the integrated 3D LF coil (white square component with L3D 
designation on PCB).
ATAN0029 [APPLICATION NOTE]
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Figure 2-2. Atmel ATA5795 Immobilizer Programming 

2.1.2 Immobilizer Normal Operation

Immobilizer functionality can be observed using the PC GUI as well as visual feedback from the ATAB0001A-V2. Place the 
key fob with its immobilizer coil aligned and close to the ATA5272-EK1 coil and press SW1 on the ATAB0001A-V2. LED0 to 
LED3 should flash and then successful authentication (vehicle is NOT immobilized) is indicated on the ATAB0001A-V2.0 by 
correct illumination of an LED in the range of LED0 to LED3 and the illumination of LED6. The position of this LED shows 
which fob caused the successful action. It is also indicated on the PC GUI by an immobilizer icon being displayed and 
corresponding vehicle start sound. Because the immobilizer is a passive function, it can be demonstrated either with or 
without the key fob battery in place.

Additional details of the authentication process and protocol can be obtained in the “Open Immobilizer Protocol Stack” 
document. A registered copy can be downloaded from this link: 
http://www.atmel.com/forms/registration_immobilizer_stack.asp?category_id=154&family_id=692&subfamily_
id=1949&fn=dl_doc9195.pdf

2.1.3 Immobilizer Learn Mode Using the GUI

The System Configuration window using the supplied GUI is used to pair new key fobs with the immobilizer system as 
follows:

1. To open the System Configuration window go to
View > System Configuration

2. Position the fob in close proximity to the base station immobilizer coil as shown in Figure 2-1 and Figure 2-2.

3. Press the “Learn” button in the Learned Fobs section of the System Configuration window to add new fobs to the 
immobilizer system. As the new fobs are added to the list of fobs, their unit IDs are populated in the Fob#1-Fob#4 
fields (see the System Configuration window in Figure 2-3 on page 20).
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2.1.4 Immobilizer Normal Operating Mode Using the GUI

Immobilizer functionality can be observed in normal operating mode by

1. Placing the key fob near the immobilizer LF coil

2. Opening the immobilizer window using the pull-down menu
View > Immobilizer

3. Pressing “Read UID” the base station sends a corresponding command to the key fob. The fob replies with the 
“Immobilizer UID” field. Note: This works even for fobs not learned to the system.

4. Pressing the “Start Authentication” button - the base station sends a “Start authentication” command to the key fob 
followed by the challenge (and/or encrypted challenge data based on authentication type).

The Immobilizer Status window shows the immobilizer status upon successful execution of a “Start authentication” 
command in Figure 2-3.

The examples below show that two key fobs (e.g., Fob#1 and Fob#2) have been learned and are paired with the immobilizer 
system. The Immobilizer Status window shows Fob#2 as being successfully authenticated.

Figure 2-3. Immobilizer Functionality Using the GUI 
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2.2 Passive Entry/Passive Start (PEPS)

PE is a vehicle access feature that eliminates the need to manually press the “LOCK/UNLOCK” buttons on the key fob. 
Instead, the vehicle generates a magnetic field around certain regions of its periphery used to wake up the key fob from a 
low power state. After wake-up, the key fob sends an RF response back to the vehicle. The learn process for this feature is 
the same as for RKE or IMM.

2.2.1 PE Learn Mode

Passive entry key learn is done indirectly by executing the LF (immobilizer) learn sequence described in Section 2.2 
“Passive Entry/Passive Start (PEPS)” on page 21.

2.2.2 PE Normal Operation

The PEPS operation is emulated by the GUI window as well as the LED array on the interface board. The PE system is used 
to unlock and lock vehicle doors and start the engine.

2.2.2.1 RSSI Calibration

The PE system uses the LF signal received from the LF driver module to compute the key fob distance from the LF driver 
antenna coil. This information is used to determine whether the key fob is located inside or outside the vehicle by comparing 
it with a predetermined vehicle boundary value.

The vehicle boundary can be set by positioning a paired key fob at the desired distance from LF antenna number 1 and 
pressing the “RSSI Cal” button (SW2). The RSSI calibration values are read by the vehicle which measures the physical 
distance and establishes a perimeter mark to be used when the system determines whether the key fob is located inside or 
outside the vehicle. To establish the new “inside/outside” reference value, just press SW2 while the fob is located at the new 
perimeter location desired. Key fob orientation does not matter because the 3D (X, Y, and Z axis) capability of the Atmel® 
ATA5791 and PEPS protocol allows a fixed value to be set regardless of the orientation of the key fob.

Note: Upon RSSI calibration, the RSSI calibration value is stored in the EEPROM pressing SW2. The calibration 
value is reloaded each time at power-up.

2.2.2.2 Door Unlock

To observe PE unlock functionality on the PC GUI, follow the steps below:

Position the LF antenna connected to the Atmel ATAB5279 6-channel coil driver board antenna 1 output (TPA1N/TPA1P) 
and place the ATAB5791A-V1.0 PEPS transmitter with 3D/1D LF application board in the outside region of the vehicle 
(distance to LF antenna exceeding the RSSI calibration mark).

Execute the “Passive entry unlock” command by pressing SW7 on the ATAB0001A-V2.0 to initiate the magnetic field 
generation associated with the doorhandle touch/pull trigger event—this means somebody wants to unlock the door. LED7 
turns on to indicate that the unlock command originated from a passive trigger (not RKE) and the illuminated LED in 
positions LED0 - LED3 on the ATAB0001A-V2 indicate which of the learned fobs successfully responded. The PC GUI 
indicates magnetic field generation in blue and a green key fob icon indicates detection of the key fob, RF transmission, and 
successful vehicles authorization (see left window in Figure 2-4 on page 22).

LED4 is used as a key fob positioning indicator. When LED4 is on, the first key fob to respond is located outside of the 
vehicle. When LED4 is off, it is located inside the vehicle.

Based on the first key fob to respond location, pushing the “Door Unlock” button (SW7) can be summarized as

1. The first key fob located inside: The door unlock command is blocked and does not unlock the door. The system 
determines upon receiving the RSSI value from the key that the fob is within the inner boundary of the vehicle. 
The fob cannot unlock the vehicle door (see right window in Figure 2-4 on page 22).

● LED7 turns on to indicate a passive trigger (not RKE) and all received fobs are shown in positions LED3 - 
LED0 on the ATAB0001A-V2. The LED4 is off to indicate a rejected command. The PC GUI displays a key fob 
in red inside the vehicle as a warning and the doors do not unlock. The red padlock indicates the doors are 
locked. This shows that if the keys are left inside the vehicle, the door cannot be unlocked by touching the 
doorhandle. 

● LED4 is switched off to indicate the fob is inside.
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2. The first key fob located outside: The door unlock command unlocks the door—normal use operation. After receiv-
ing the RSSI value from the key, the system determines that the fob is outside the vehicle. LED7 turns on to 
indicate a passive trigger (not RKE) and all received fobs are shown in positions LED3 - LED0 on the ATAB0001A-
V2.0 (see left window in Figure 2-4).

● The PC GUI displays a key fob in green outside the vehicle with the green padlock indicating the vehicle is 
locked.

● LED4 is switched on to indicate the fob is outside.

Figure 2-4. Passive Keyless Entry - UNLOCK 

2.2.2.3 Door Lock

Push SW6 to passively lock the doors. This emulates a driver locking the vehicle by pushing a button or touch sensor on the 
doorhandle. The PE lock function shows two different use cases. 

Depending on the location of the key fob, pushing the “Door Lock” button (SW6) can be summarized as

1. The first key fob located inside. The door lock command is blocked and does not lock the door. The system deter-
mines upon receiving the RSSI value from the key that the fob is within the inner boundary of the vehicle. The fob 
cannot be locked in the vehicle (see left window in Figure 2-5 on page 23).

● LED7 turns on to indicate a passive trigger (not RKE) and all received fobs are shown in positions LED3 - 
LED0 on the ATAB0001A-V2. LED4 is off to indicate a rejected command. The PC GUI displays a key fob in 
red inside the vehicle as a warning and the doors unlock as indicated by the icon and sound. This indicates that 
keys left in the vehicle by accident cannot be inadvertently locked inside.

● LED4 is switched off to indicate the fob is inside.

2. The first key fob located outside. The door lock command locks the door - normal use operation. Upon receiving 
the RSSI value from the key, the system determines that the fob is outside the vehicle. LED7 turns on to indicate a 
passive trigger (not RKE) and all received fobs are shown in positions LED3 - LED0 on the ATAB0001A-V2 (see 
right window in Figure 2-5 on page 23).

● The PC GUI displays a key fob in green outside the vehicle with the red padlock indicating the vehicle is 
locked.

● LED4 is switched on to indicate the fob is outside.
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Figure 2-5. Passive Keyless Entry - LOCK 

2.2.2.4 Passive Start (PS): Backup and Normal Operation

Passive start is a feature that enables the user to start the engine by pressing a push button mounted in the interior of the 
vehicle, typically on the dashboard. This eliminates the need for a mechanical key. The push button triggers the generation 
of a magnetic field in the interior of the vehicle which is measured by the key fob. If the key fob detects magnetic field 
strength corresponding to a location within the vehicle and the vehicle can authenticate the key fob to the vehicle, the engine 
is allowed to start.

This feature can be observed with the ATAB5791A-V1.0 PEPS transmitter with 3D/1D LF application board using key inside 
and key outside operating scenarios.

1. The first key fob located inside: Upon pushing SW0 and after receiving the RSSI value from the key, the system 
determines that the fob is within the inner boundary of the vehicle. IN/OUT LED4 is off to indicate the fob is inside 
the vehicle.

2. LED in LED3 - LED0 position on the ATAB0001A-V2.0 shows all successfully received fobs.

3. The PC GUI indicates this process as shown in Figure 2-6 on page 24.
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Figure 2-6. Passive Start - Successful Request 

1. The first key fob located outside: Upon pushing SW0 and after receiving the RSSI value from the key, the system 
determines that the fob is outside the vehicle boundary. IN/OUT LED4 is on to indicate the fob is outside the 
vehicle.

2. LED in LED3 - LED0 position on the ATAB0001A-V2.0 shows all successfully received fobs.

3. The PC GUI displays unsuccessful engine start requests as shown in Figure 2-7 on page 25 below. Notice that the 
engine immobilizer remains red (disabled) in the figure because the key fob is located outside and the engine is 
blocked from being started.
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Figure 2-7. Passive Start - Unsuccessful Request 

The system also includes a contingency in case the battery is empty in either the ATAB5791A-V1.0 or the ATAB5795C-V1.0 
key fobs. To observe this, remove the battery and place the immobilizer coil of the key fob PCB aligned and close to the 
ATA5272-EK1 base station coil. Pressing SW0 triggers the passive start function as before. However, because the system 
does not receive an RF response (e.g., the fob battery is removed or empty), the PS request times out with the immobilizer 
protocol function immediately after the PS attempt is completed. This time, LED6 lights up to indicate the backup immobilizer 
was the source of authentication to start the engine. This is also displayed on the PC GUI as shown in Figure 2-8 on page 
26.
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Figure 2-8. Backup Passive Start Using the Immobilizer 

2.2.3 Using the PEPS System with the GUI-v2

When using the supplied GUI, the PEPS system can be easily configured via the System Configuration window. To open this 
window, go to

View > System Configuration

To view PEPS functionality, open the PEPS Message Status window from the pull-down menu

View > PEPS Messaging

2.2.3.1 Key Fob Pairing

The key fobs can only be paired with the system from the System Configuration window, regardless of whether the 
immobilizer, the PEPS, or the RKE functionality are to be used.

The immobilizer learn mode must be used to pair a key fob from the GUI. To add a new key fob, the fob must be placed in 
the direct proximity of the immobilizer base station coil and the “Learn” button pressed in the “Learned Fobs” section of the 
System Configuration window.

Once a new key fob is added to the system (it is learned by the immobilizer, PEPS, and RKE system), it can be used either 
as an immobilizer fob, a PEPS fob, or an RKE fob.
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2.2.3.2 Identifying Fobs in Range

The available fobs can be identified by transmitting a broadcast request which returns the Fob# in the selected fob field: 

To identify available fobs within the LF range,

1. Select “Broadcast” in the selected fob field.

2. Push the “Fob ID” button under it to transmit the broadcast request. The available fob responds with its fob ID and 
Fob# assignment. The associated vehicle ID is returned in the “Fob Vehicle ID” field.

3. Push the “S/W Ver” button under it to send the S/W version request to the key fob. The key fob responds with the 
software version number.

Notes: 1. To use the broadcast function, ONLY one key fob should be in range and this key fob must have an installed 
battery in the battery socket to support the PEPS functionality.

2. This function works for fobs not paired with the current system AND fobs which have a different vehicle ID. The 
selected fob index changes to the value the fob believes it is stored in. The fob ID should be verified by com-
paring it to the “Learned Fobs.” 

2.2.3.3 Key Fob Calibration

In the PEPS system the enabled key fobs receive an LF signal and measure its strength as a receive signal strength 
indicator (RSSI) value. This value is then used by the vehicle to determine the position of the fob in relation to the 
transmitting LF antenna. To ensure RSSI accuracy, the PEPS fobs must be calibrated, including signal normalization and 
compensation on all three axes (X, Y, and Z axis). This is also known as end-of-line (EOL) calibration and can be performed 
during the final test at the manufacturing facility. With the help of the GUI, normalization and compensation are performed 
automatically by pressing the “Calibrate Fob” button in the System Configuration window.

The normalization procedure consists of measuring a signal on each antenna coil (X, Y, and Z) with a desired RSSI value set 
by the user. This normalization procedure is performed at the fixed distance (d=50cm) to the receiving antenna for each key 
fob antenna axis. Any deviation between the measured result and the desired reference value is stored as the Normalization 
Constant for each axis. Because the RSSI values are measured, their normalization constants are stored for each axis 
antenna individually.

The calibration cycle must be performed for each fob individually.

To perform the calibration fob cycle,

1. Select the fob to be calibrated in the “Selected Fob” field.

2. Press the “Calibrate Fob” button in the System Configuration window.

3. Type the desired RSSI value into the “Desired RSSI” field in the EOL Configuration window and press Next. 

Notes: 1. Note that if the desired calibration value constant is close to the measured RSSI value at the reference dis-
tance of 50cm, the normalization offset is minimal. This is desirable to take advantage of the entire dynamic 
range available (0-255) because the measurement results may be clipped due to large normalization offsets.

2. The desired RSSI value should be identical for ALL fobs in order to provide consistent system response across 
the entire fob population.

4. Determine the normalization for the X axis. Position the LF transmitting antenna and the key fob as shown in the 
Fob EOL Configuration window to measure the X axis RSSI value and press the “Measure” button. This measures 
the current signal amplitude and adds the result to the “Peak RSSI” field for the X axis. Notice that the normaliza-
tion constant is automatically inserted. Press Next.

5. Determine the normalization for the Y axis. Position the key fob as displayed to measure the Y axis RSSI value 
and press the “Measure” button. This measures the current signal amplitude and adds the result to the “Peak 
RSSI” field for the Y axis. The normalization constant is automatically inserted as well. Press Next.

6. Determine the normalization factor for the Z axis. Repeat the same measurement for the Z axis. This normaliza-
tion step is shown below in Figure 2-9 on page 28. The normalization constants for the X, Y, and Z axis have been 
added while the Desired RSSI value is set to 145 for this example. Press Next to proceed with measuring and 
adding the compensation constants.
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Figure 2-9. PEPS System Fob Calibration 

7. Press the “Configure” button to measure and store the compensation constants. Press the “LF Test” button in the 
System Configuration window to check both calibration constants (normalization and compensation for each axis) 
and display them in the respective fields in the “PEPS Fob Action” section of the System Configuration window 
(see Figure 2-10 on page 29). The calibration cycle must be performed for each fob separately. The fob to be cal-
ibrated is selected in the “Selected Fob” field. 

The built-in compensation measurement is based on

(1) Measuring the internal RSSI (no LF signal present) 

(2) Measuring the RSSI values at the reference conditions and 

(3) Measuring the current RSSI values 

The actual or real RSSI amplitude is then calculated by subtracting any non-ideal influences (such as magnetic flux 
disturbances due to adjacent ferrite bodies or temperature effect) by subtracting the non-ideal error from the values 
measured at (3). This compensation (difference values) is displayed in the “Compensation” field for each axis.
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Figure 2-10. PEPS System Fob Compensation 

8. In/out threshold RSSI level is used to determine whether the key fob is outside or inside the car. Enter the RSSI 
threshold value in the corresponding field in the System Configuration window.

As the fob is moved closer to the transmitting LF antenna and the measured RSSI values become larger than the 
threshold value, the PEPS Message window indicates the fob is “Outside.”

9. To run the PEPS system, open the PEPS Message Status window from the pull-down menu
View > PEPS Message

10. Activate the “PEPS UA” button to execute the unilateral authentication sequence. Note that the “LF Encrypted 
Challenge” field is empty because this data is not transmitted to the fob.

An example of the PEPS Message Status window indicating the results of PEPS unilateral authentication sequence is 
shown in Figure 2-11 on page 30. With the “In/Out Threshold” = 145, the measured value read as “Distance Scale” = 
211 above the “PEPS UA” button, activation is greater than the threshold level and is marked in blue overlay as being 
inside the vehicle.
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Figure 2-11. PEPS Unilateral Authentication 

11. Move the key fob farther away from the LF transmitting antenna while staying within PEPS' operating range (this 
should result in a much smaller RSSI value being measured). 

Then click the “PEPS BA” button to execute the bilateral authentication sequence. A PEPS Message Status window 
displaying the resulting data is shown in Figure 2-12 on page 31. Notice that the measured RSSI value shown as “Dis-
tance Scale” = 123 is less than its “In/Out Threshold” = 145. This results in the pink overlay for the result of Key#2, 
indicating the key fob is located outside the vehicle.
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Figure 2-12. PEPS Bilateral Authentication 

2.2.3.4 PEPS Features for Polling

The PEPS system can be put in polling mode when the LF signal is repeatedly transmitted to the PEPS key fob. The LF 
transmission is sent and the RF response is received regularly at the polling interval.

To choose the protocol, click either the “Unilateral Authentication” or “Bilateral Authentication” radio button.

To enable PEPS polling, set the polling interval in the PEPS features section in the System Configuration window and check 
the “Polling” box. The polling feature can be used to dynamically determine the PEPS key fob area coverage in real time with 
the PEPS results shown in the GUI window. The polling interval is defined in milliseconds below.
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2.3 Remote Keyless Entry (RKE) 

RKE is a feature that allows authorized users to lock or unlock their car remotely. RKE operation requires that a lithium 
battery (CR2032 or equivalent) be inserted in the fob. The RF message propagates in all directions with a range of 30m or 
more. This message contains information that is used to confirm the identity and verify authenticity of the user. Security is 
provided by AES-128 cryptography and a specialized protocol.

2.3.1 Learn Mode

Before RKE system functionality can be used, the RF transmitter and key fob must be paired to the vehicle. This process 
involves placing the vehicle’s receiver in a mode that allows it to learn the secret key contained in the key fob.

Note: RKE learn mode is supported by Atmel® ATA5795 and ATA5774 key fob devices only. RKE learn mode is not 
supported by the Atmel ATA5791 IC key fob. For this device the RKE secret key is learned using the LF learn 
mode described in Section 2.2 “Passive Entry/Passive Start (PEPS)” on page 21.

In learn mode the RKE transmitter sends its device ID/secret key to the vehicle (the vehicle learns the ID/secret key of the 
transmitter device). The ID/secret key of the device is sent from the fob to the vehicle in a secure manner. The key fob 
encrypts the secret key with a key shared by the vehicle and the fob. These cryptographic keys are only used to ensure that 
the pairing information sent from the key fob to the receiver is secret. 

A standard RF communication link is used that consists of data packets containing (listed in data order) a preamble, device 
serial number (32b), sequential counter value (32b), encrypted key data (128b), and the CRC-16 value. Upon reception the 
vehicle can decrypt the secure data and add the fob secret key to the list of associated (learned) devices.

The vehicle side of the RKE link enters the learn mode first. The learn mode is entered by pressing SW5 on the 
ATAB0001A-V2. LED5 turns on, indicating the learn mode is active. Press the S1 switch to pair a key fob during the next 10 
second period.

Successful learning is indicated by the LED5 flashing the memory position to which the fob was learned once when turning 
on 
(LED0 - LED3), and the Learn Mode icon (a graduate's mortarboard) being briefly displayed on the PC GUI.

As long as LED5 remains on, the learn mode is active and the other transmitters supplied with this kit can be learned too. 
Just press SW1 on the other key fobs to pair each with the vehicle.

To exit the learn mode, either press SW5 on the ATAB0001A-V2.0 or let the 10 second period lapse. LED5 turns off 
indicating normal operation. 

Note: The RKE system is only operational when the learn mode is exited (LED5 is off) and the system is paired with 
a key fob.

Up to four key fobs in total can be paired (learned) with the vehicle.

2.3.2 Normal Operation

RKE functionality can be observed using the PC GUI on the computer terminal and/or the visual LED feedback from the 
ATAB0001A-V2.

Pressing the transmitter “LOCK” button (S3 on ATA5771/73/74-EK1 and ATA5795-EK1) or “UNLOCK” button (S2) 
repeatedly causes the LED associated with that fob (LED0 - LED3) to flash several times before staying on. This only occurs 
if the AES encryption is valid.

ATAB5791A-V1.0 responds somewhat differently because all three buttons provide RKE command messages. Each button 
features two types of press actions. There is a short button press and a long button press event, with each handled 
differently. Table 2-1 shows how these are currently configured. In all cases, the LED corresponding to the learned memory 
position flashes several times before staying on.

Table 2-1. RKE

S1 S2 S3

Short Press Lock Unlock driver door Open trunk

Long Press Remote start Unlock all doors Close trunk
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The long press of S1 provides a very specific case. The other button presses all transmit using FSK modulation at 9.6Kbaud. 
To achieve longer ranges with remote start, a long press of S1 changes to ASK modulation at 1Kbaud. This shows the high 
degree of flexibility possible for transmitting and receiving devices.

In order to provide very good performance in the presence of noise, all RKE messages are transmitted on three different 
UHF channels. This makes it more likely that at least one of the messages will be successfully transmitted. This requires that 
the RF transmitter is capable of supporting such features so the ATA5771/73/74-EK1 is the only fob that cannot do this multi-
channel RKE.

The PC GUI supplies additional information such as transmitter ID, sequence counter, command, encryption, and status in 
the RF Message Status window. Watch the icon located in the center of the car and listen for additional feedback on the 
status of the RKE system.

For additional information on the RF protocol, see AVR411 available on our Atmel website: 

http://www.atmel.com/images/atmel-2600-avr411-secure-rolling-code-algorithm-for-wireless-link_application-note.pdf

2.3.3 Using the RKE System with the GUI

The GUI can also be used to configure and operate the RKE system. 

The RKE system must be configured before normal operation. The configuration involves a learn sequence procedure 
identical to that of learning the immobilizer secret keys where the secret keys are transferred from the vehicle (the interface 
PCB module) to each key fob. Once this learn procedure is completed for each key fob, the GUI can be used to monitor the 
status of RKE functionality.

See Section 2.1.3 “Immobilizer Learn Mode Using the GUI” on page 19 for details about the key fob pairing procedure.

2.3.4 RKE Normal Operation

Once one or more key fobs are paired with the system, open the System Configuration and the RKE Message Status 
windows.

To open the System Configuration window, go to

View > System Config

To open the RKE Message Status window, go to

View > RKE Messaging

2.3.4.1 Displaying Paired Key Fobs in the System Configuration Window

Once the pairing procedure is complete, the System Configuration window displays the paired fobs in the “Learned Fobs” 
section. There are two learned fobs shown in Figure 2-13

● Fob#1 with C1E00002 ID 

● Fob#2 with C1E00001 

that are associated with the ATAB0001A-v2.0 PCB. Both fobs are paired with the vehicle and have unique secret keys which 
are used to send RKE messages to the vehicle.

Up to four RKE or PEPS key fobs can be paired with the system.

2.3.4.2 Sending RKE Messages

The RKE messages are sent to the vehicle by pressing the push buttons.

On the PEPS key fob (ATAB5791A-V1.0),

● Pushing S1 sends the door lock command

● Pushing S2 sends the door unlock command
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2.3.4.3 RKE Message Status Window

The RKE Message Status window is shown in Figure 2-13. In contains the status fields

● RF Message S/N: C1E0001. It contains the unit ID returned by the key fob. The same UID value for a given fob is 
shown in the “Learner Fobs” section of the System Configuration window.

● RD Message Counter: 118181488. It contains the rolling code message counter value which is sent to the vehicle. 
This value is incremented for every key push. Both commands (e.g., lock and unlock) increment the counter value 
RC.

● RF Message Command: 01 = Lock. It shows the most recent command received from the key fob. Possible 
commands include (a) 01=Lock and (b) 02=Unlock Driver.

● RF Message MAC: 0A4B0BE4. It contains a 4-byte (32-bit) MAC computed as
MAC[31:0]=AES-128{UID[31:0],RC[31:0],Padding_0[63;0]} 

● RF Message Result: Valid Key Found. This field is the most recent status message received by the system.

● RF Channel. This field shows which channel the message was received on cleanly. 

● RF RSSI. The signal strength sampled at the UHF receiver is measured and displayed in three formats. There is 
representation directly from the Atmel® ATA5782 device in decimal notation followed by a calculated dBm value. 
Finally there is a bar graph that can be used as a visual representation.

The received RKE command message is shown in the RKE Messaging window.

Figure 2-13. RKE Normal Operation Using the GUI 
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3. Source Code Modification

Flash and EEPROM programming is required for all boards that contain an AVR® microcontroller and can be accomplished 
using in-system programming (ISP). The affected PCB assemblies are noted below.

● ATAB0001A-V2.0 car access interface board ISP headers

● ATA5771/73/74-EK1 transmitter application board

● ATA5795-EK1 transmitter with 1D LF application board

● ATAB5791A-V1.0 PEPS transmitter with 3D/1D LF application board

● ATA5272-EK1 base station application board

● ATA5782C-V1 RF receiver application board

3.1 Adding New Device Support to AVR Studio4

Support for the following devices must be added to AVR Studio®: (1) Atmel® ATA5791, (2) ATA5795, (3) ATA5782. All files 
referenced below are included with this kit.

Note: [Studio install path] is typically C:\Program Files\Atmel\ 
[IAR install path] is typically C:\Program Files\IAR Systems\Embedded Workbench 5.4

For the AVR Studio4 support file the following files must be properly located:

● The “ata5791.xml” and “ata5795.xml” and ata5782.xml files go into [Studio install path]\AVR Tools\Partdescriptionfiles

● The “ata5791def.inc” and “ata5795def.inc” files go into [Studio install path]\AVR Tools\AVRAssembler\Appnotes

● The “ata5791def.inc” and “ata5795def.inc” files go into [Studio install path]\AVR Tools\AVRAssembler2\Appnotes

For general support, the following files must be properly located and edited:

● The ATA5791.h file goes into the root folder of your project.

● Edit the “[Studio install path]\AVR Tools\Compilers\.supportedparts.txt” file by adding two new lines; one for Atmel 
ATA5791 and one for Atmel ATA5795.

For IAR compiler support, the following files must be properly located:

● The “ioata5791.h” and “ioata5795.h” files go into [IAR install path]\avr\inc

● The “lnkata5791.xcl” and “lnkata5795.xcl” files go into the root folder of your project.

3.2 Programming the ATmega2560 on CAR System Interface Board

Note: The Atmel ATmega2560 on the ATAB0001A-V2.0 board is shipped fully programmed so that the steps 
described below are not normally necessary. 

If it is necessary to reprogram the Atmel ATmega2560 on an ATAB0001A-V2.0 PC board, connect the programmer cable 
(e.g., JTAGICE MKII) either to the JTAG or the ISP header with the head placed on the left perimeter of the ATAB0001A-
V2.0 PCB (see Figure 3-1).

Figure 3-1. ATAB0001A-V2.0 Car Access Interface Board ISP Headers 
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Please refer to Figure 3-2 to Figure 3-5 on page 38 for a series of screenshots on how to carry out the programming steps 
described below.

With AVR Studio4, program the Atmel® ATmega2560 by clicking the “Display the 'Connect' Dialog” icon and in the Select 
Programmer menu select

Platform: JTAGICE MKII 

Port: USB

Atmel ATmega2560 can be programmed using either the JTAG or the ISP programming header. 

Programming with JTAG: When using the JTAG header, connect the JTAGICE mkII programming cable to the JTAG header 
and select “JTAGICE mkII” as the programmer and “USB” and then press the “Connect” button to display the Programming 
window (Figure 3-2). Click the “Main” tab and select the Atmel ATmega2560 device. Press the “Read Signature” button to 
check the signature matches the selected device. Click the “Fuses” tab and check that the fuse settings are correct (Figure 
3-3 on page 37). Next, click the “Program” tab and browse to the “ATAK51003-V1_ ATAB0001A-V2.hex” file for the Flash 
memory image and the “AOIP_Vehicle_BS.eep” file (Figure 3-5 on page 38). The files can be found in the distribution files 
supplied with this kit.

Figure 3-2. JTAGICE mkII Connection Dialog via USB 

Programming with ISP: When using the ISP header, connect the JTAGICE mkII ISP programming cable to the ISP header 
and follow the instructions given for the JTAG option. However, be sure to set the ISP programming frequency to 100kHz or 
less.
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Figure 3-3. Main ISP Programming Window for the ATmega2560 

Figure 3-4. Fuse Setting Window for the ATmega2560 
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Figure 3-5. Program Window for the ATmega2560 

3.2.1 Adding New Device Support to AVR Studio4

Support for the new devices included in this evaluation kit must be added to AVR Studio®. All files referenced below are 
included with this kit.

Note: The [Studio install path] is typically C:\Program Files\Atmel\
The [IAR install path] is typically C:\Program Files\IAR Systems\Embedded Workbench 5.4

For the AVR Studio4 support file, the following files must be properly located:

● The “ata5791.xml,” “ata5795.xml” and “ata5782.xml” files go into [Studio install path]\AVR Tools\Partdescriptionfiles

● The “ata5791def.inc” and “ata5795def.inc” files go into [Studio install path]\AVR Tools\AVRAssembler\Appnotes

● The “ata5791def.inc” and “ata5795def.inc” files go into [Studio install path]\AVR Tools\AVRAssembler2\Appnotes

For general support, the following files must be properly located and edited:

● The “ATA5791.h” file goes into the root folder of your project

● Edit the “[Studio install path]\AVR Tools\Compilers\.supportedparts.txt” file by adding two new lines; one for Atmel® 
ATA5791 and one for Atmel ATA5795.

For IAR compiler support, the following files must be properly located:

● The “ioata5791.h” and “ioata5795.h” files go into [IAR install path]\avr\inc

● The “lnkata5791.xcl” and the “lnkata5795.xcl” files go into the root folder of your project
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3.2.2 Programming the ATA5272-EK1 Base Station 

Prepare the ATA5272-EK1 base station application board (including coil) for programming by removing the PA4/OUT 
jumper. The AVR® microcontroller contained in the Atmel® ATA5272 is an ATtiny87. Figure 3-6 shows a series of 
screenshots on how to carry out the programming. With AVR Studio4, program the ATtiny87 using a programmer (e.g., 
JTAGICE MKII) and follow the same steps described in the previous section. Click the “Display the 'Connect' Dialog” icon 
and select “JTAGICEII” and “USB” and then press the “Connect” button to display the Programming window. Click the “Main” 
tab and select the ATtiny87 device. Be sure to set the ISP frequency to 100kHz. Check that the fuse settings are correct and 
the target voltage is set to 5.0V. Return to the “Main” tab and verify proper setup by clicking “Read Signature” and check that 
the signature matches the selected device. Next, click the “Program” tab and browse to the “ATAK51003-V1_ATA5272.hex” 
file for programming into Flash and the “AOIP_Vehicle_BS.eep” file for programming into EEPROM. The files can be found 
in the distribution files supplied with this kit.

Note: The corresponding configuration file for the ATAK53001-V1 kit is shown in Figure 3-6.

After programming, be sure to return the PA4/OUT jumper to its original location for normal operation.

Figure 3-6. Connection Dialog Window for the ATA5272-EK1 Base Station Application Board 
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Figure 3-7. Main ISP Programming Window for the ATA5272-EK1 Base Station Application Board 

Figure 3-8. Fuses Window for the ATA5272-EK1 Base Station Application Board 
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Figure 3-9. Hardware Settings Window for the ATA5272-EK1 Base Station Application Board 

Note: The corresponding configuration file for the ATAK53001-V1 kit is shown in Figure 3-10.

Figure 3-10. Program Window for the ATA5272-EK1 Base Station Application Board 
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3.2.3 Programming the Atmel ATA5774 Transmitter

Prepare to program the Atmel® ATtiny44 contained in the Atmel ATA5774 IC by connecting the 6-wire ISP cable of the ISP 
programmer (e.g., JTAGICE MKII) to the 6-pin header on the ISP interface adapter. Insert the ATA5771/73/74-EK1 
transmitter application board into the edge card connector on the ISP interface adapter.

Note: Be sure to remove the battery from the ATA5771/73/74-EK1 transmitter application board and set the target 
voltage to 3.0V prior to programming the ATtiny44.

Please refer to Figure 3-11 and Figure 3-15 on page 44 for a series of screenshots on how to carry out the programming 
steps below. With AVR Studio4, program the Atmel ATtiny44 using the STK600 following the same steps described in the 
previous section. Click the “Display the 'Connect' Dialog” icon. Select “JTAGICEII” and “USB” and then press the “Connect” 
button to display the Programming window. Click the “Main” tab and select the ATtiny44 device. Be sure to set ISP frequency 
to 100kHz. Check that the fuse settings are correct and the target voltage is set to 5.0V. Return to the “Main” tab and verify 
proper setup by clicking “Read Signature” and check that the signature matches the selected device. Next, click the 
“Program” tab and browse to the “ATAK51003-V1_ATA577x.hex” file for programing into Flash and the “ATA577x_ID1.eep” 
file for programming into EEPROM. The files can be found in the distribution files supplied with this kit.

Figure 3-11. Connection Dialog Window for the ATA5771/73/74-EK1 Transmitter Application Board 
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Figure 3-12. Main ISP Programming Window for the ATA5771/73/74-EK1 Transmitter Application Board 

Figure 3-13. Fuses Window for the ATA5771/73/74-EK1 Transmitter Application Board 
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Figure 3-14. Hardware Settings Window for the ATA5771/73/74-EK1 Transmitter Application Board 

Note: The corresponding configuration file for the ATAK53001-V1 kit is shown in Figure 3-15.

Figure 3-15. Program Window for the ATA5771/73/74-EK1 Transmitter Application Board 
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After programming is complete and the board is disconnected from the ISP cable, be sure to insert the battery to resume 
normal operation.

3.2.4 Programming the ATAB5791A-V1.0 PEPS Transmitter

Program the Atmel® ATA5791 by connecting the 6-wire ISP cable of the ISP programmer (e.g., JTAGICEII) to the 6-pin ISP 
header located on the ATAB5791A-V1.0 PEPS transmitter board. To start programming, go to Tools > AVR Programming to 
display the ISP menus. Click the “Display the 'Connect' Dialog” icon. Select the ISP programmer being used (e.g., “JTAGICE 
mkII”) and “USB” and then press the “Connect” button to display the Programming window. Click the “Main” tab and select 
the Atmel ATA5790 device. Be sure to set ISP frequency to less than 100kHz! Check that the fuse settings are correct and 
the target voltage is set to 3.0. Return to the “Main” tab and verify proper setup by clicking “Read Signature” and check that 
the signature matches the selected device. Next, click the “Program” tab and browse to the “ATAK51003-
V1_ATAB5791A.hex” file and “AOIP_ATA5791_KF1.eep” file as shown in Figure 3-16. The files can be found in the 
distribution files supplied with the CARS kit.

Note: Be sure to remove the battery from the ATAB5791A-V1.0 PEPS transmitter and set the target voltage to 3.0V 
prior to programming the Atmel ATA5791.

Figure 3-16. Connection Dialog Window for the ATAB5791A-V1.0 PEPS Transmitter Application Board 

Figure 3-17. Main ISP Programming Window for the ATAB5791A-V1.0 PEPS Transmitter Application Board 
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Figure 3-18. Fuses Window for the ATAB5791A-V1.0 PEPS Transmitter Application Board 

Figure 3-19. Hardware Settings Window for the ATAB5791A-V1.0 PEPS Transmitter Application Board 

Note: The corresponding configuration file for the ATAK53001-V1 kit is shown in Figure 3-20.
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Figure 3-20. Program Window for the ATAB5791A-V1.0 PEPS Transmitter Application Board 

After programming is complete and the board is disconnected from the ISP cable, be sure to insert the battery to resume 
normal operation.

3.2.5 Programming the ATA5795-EK1 Transmitter

Program the Atmel® ATA5795 device by connecting the 6-wire ISP cable of the ISP programmer (e.g., JTAGICEII) to the 6-
pin ISP header on the ATA5795-EK1 transmitter board.

Be sure to remove the battery from the key fob and set the target voltage to 3.0V prior to programming the Atmel ATA5795.

Please refer to Figure 3-21 to Figure 3-25 on page 50 for a series of screenshots on how to carry out the programming steps 
below. With AVR Studio4, program the Atmel ATA5795 using the JTAGICEII ISP programmer connection following the same 
sequence of steps described in the previous section. Click the “Display the 'Connect' Dialog” icon. Select the preferred ISP 
programmer (e.g., JTAGICEII) and “USB” and then press the “Connect” button to display the Programming window. Click the 
“Main” tab and select the Atmel ATA5795 device. Be sure to set ISP frequency to less than 100kHz! Check that the fuse 
settings are correct and the target voltage is set to 3V. Return to the “Main” tab and verify proper setup by clicking “Read 
Signature” and check that the signature matches the selected device. Next, click the “Program” tab and browse to the 
“ATAK51003-V1_ATA5795.hex” file for programming into Flash and the “AOIP_ATA5795_KF.eep” file for programming into 
EEPROM. The files can be found in the distribution files supplied with this kit.

Figure 3-21 to Figure 3-25 on page 50 show STK600 as the ISP programmer being used.
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Figure 3-21. Connection Dialog Window for the ATA5795-EK1 Transmitter Application Board 

Figure 3-22. Main Window for the ATA5795-EK1 Transmitter Application Board 
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Figure 3-23. Fuses Window for the ATA5795-EK1 Transmitter Application Board 

Figure 3-24. Hardware Settings Window for the ATA5795-EK1 Transmitter Application Board 

Note: The corresponding configuration file for the ATAK53001-V1 kit is shown in Figure 3-25 on page 50.
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Figure 3-25. Program Window for the ATA5795-EK1 Transmitter Application Board 

After programming is complete and the board is disconnected from the ISP cable, be sure to insert the battery to resume 
normal operation.

3.2.6 Programming the Atmel ATA5782 Receiver

Program the Atmel® ATA5782 device by connecting the 6-wire ISP cable of the ISP programmer (e.g., JTAGICEII) to the 6-
pin ISP header on the Atmel ATA5782 transmitter board.

Please refer to Figure 3-26 on page 51 for a series of screenshots on how to carry out the programming steps below. With 
AVR Studio4, program the Atmel ATA5782 using the ISP programmer (e.g., JTAGICEII). Establish the connection in the 
same sequence of steps described in the previous section. Click the “Display the 'Connect' Dialog” icon. Select the preferred 
ISP programmer (e.g., JTAGICEII) and “USB” and then press the “Connect” button to display the Programming window. 
Click the “Main” tab and select the Atmel ATA5782 device. Be sure to set ISP frequency to less than 100kHz!

Note: The Atmel ATA5782 device is in sleep mode at power-up. For the ISP to connect to the device, briefly supply 
0V to the TRIPA/TRIPB test points on the Atmel ATA5782 application PCB to trigger a wake-up voltage level.

Once Atmel ATA5782 is awake, the ISP connection can be established and the device signature read in the “Main” tab. 
Make sure the fuse settings are correct and the target voltage is set to 3V.

Next, click the “Program” tab and browse to the files to be programmed into EEPROM. The files can be found in the 
distribution files supplied with this kit.

Figure 3-26 to Figure 3-28 on page 52 show device programming when the JTAGICEII is used as the ISP programmer.
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Figure 3-26. The JTAG mkII in ISP Mode Connecting to the Atmel ATA5782 

Figure 3-27. Fuses Window for the Atmel ATA5782 RF Receiver Application Board 

Select the “ATAB0003A-ATA5782.eep” file to be downloaded to Atmel® ATA5782 EEPROM and program the data by 
clicking the “Program” button in the EEPROM section. Atmel ATA5782 does not need to have Flash memory programmed in 
this application.

Note: The corresponding configuration file for the ATAK53001-V1 kit is shown in Figure 3-28 on page 52.
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Figure 3-28. Programming EEPROM of the ATA5782 on the RF Receiver Application Board 
ATAN0029 [APPLICATION NOTE]
9306C–RKE–03/15

52



4. Troubleshooting

Table 4-1. Troubleshooting Guide

Problem Cause Solution

A warning message indicates that ISP 
programming does not work

The AVR device is in debugWIRE 
mode

Consult the AVR Dragon or JTAGEICE 
mkII user guide for instructions on how 
to clear debugWIRE mode. A project 
must be opened and a debug session 
run for this.

ISP clock frequency is set too high
With AVR Studio4, set ISP to 100kHz or 
less.

The PKE function does not work

VTARGET on ATAB0001A-V2.0 is not 
set to 5V

With AVR Studio4, set VTARGET to 5V.

LF driver antenna connection is not 
sufficient

Recheck the connection of the LF 
antennas. The connection may be 
loose.

The key fob is not waking up
Check to see if the LED is flashing on 
the key fob. Remove the battery and put 
it back in to reset the software.

RF reception is corrupted
Check for other sources of RF noise or 
transmissions. 

RKE or PKE function does not work

CR2032 lithium battery not inserted in 
socket (Atmel ATA5791, ATA5795, and 
ATA5774 handheld PCBs)

RF reception is corrupted
Check for other sources of RF noise or 
transmissions. 

Immobilizer does not function

The key fob transponder orientation is 
incorrect

Because of the properties of a magnetic 
field, the antennas must be correctly 
aligned.

The base station coil is placed on or 
near metal surfaces

Metal detunes the antenna resonant 
circuit. This can be fixed by moving the 
antenna or by retuning.

Key fob transponder is too far away

The immobilizer draws all power to 
operate from the LF field. This means 
that the range of operation is quite 
small. Typically < 20cm

PA4/OUT jumper removed

This provides the demodulated data 
from the LF reader to the microcontroller 
for processing. This data must be 
removed but also replaced when 
reprogramming the microcontroller.

Cannot read device signature in ISP 
mode

12V supply not connected to 
ATAB0001A-V2.0. Some power is 
supplied through USB connection, but 
not for ISP programming.

In addition to connecting USB between 
ATAB0001A-V2.0 and the host PC, 
connect the 12V wall transformer output 
to the ATAB0001A-V2.0.
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5. Revision History

Please note that the following page numbers referred to in this section refer to the specific revision mentioned, not to this 
document.

Revision No. History

9306C-RKE-03/15 Put document in the latest template
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